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Dashboards is a feature in Spatial XL and all our spatial products that allows

you to get various graphs and data out of your spatial data in graphics for analy-
SiS.

i% Layers = Dashboards

Dashboards can also be accessed from the View tab and selected if it is not pre-
sent as a tab next to Layers.
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SpatialXL
285 Data View Draw Edit Selection Tools Utilities
:: Zoom Fit 0{-' Pan ]:}' Standard from current ] View 3 E Layers
,&7 Zoom In <@ Orientation + El Main View i Minimap
,B' Zoom Out ;ﬁ Script Buttons | [a2] View 2 o] view 4 A Dashboards
View Layout
Licensing

To create Dashboards, you require a Bi description in your license file. If you
do not have this description in your license file, you will only be able to view
Dashboards that have already been set up.

J) PTS5-5patialXL-Plus,Bi,Briefcasesb,ODA,Storyboard-wayne-20201231

Designing Dashboards

Select the Dashboards tab and click on Add a Dashboard.

A window will come up. Click on Yes.

SpatialXL X

Are you sure you want to create a new dashboard?

Yes Nao Cancel
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The Dashboard Designer will open now.

% Dashboard Designer - New DashBoard - O X
=0 g
B- Home Data Source View A

9 . AB
e - Geo Point Maps v Images ¥ Title
D Pl [GIQ @ EE IR Ry Qoo M O
= = = Range Filter Text Box © Currency C!.
News Pivot  Grid Chart Scatter Pies Gauges Cards Treemap Choropleth .
L Chart Map Filter Elements » r. Group Edit Colors
File Hist... Insert Dashboard

Data Source

New DashBoard th

Google Roads

= 1z i

v E] Google Roads
|ob| quadkey
[122] LoD
[123] Tilex
[123] Tiley

bios] Geometry To add a dashboard item to your dashboard, dlick the corresponding
button in the Ribbon or the Toolbar

Choose the appropriate Data Source that you would like to create Dashboards
for. In this example I chose the layer POP CENSUS SUB PLACES as my
Data Source.

Data Source

Google Roads =

Google Roads -
! POP CENSUS SUB PLACES
J SALES AREAS

Radius 10km

Radius Skm

Radius 2km

Centres -

In the Home tab is where you can select in what form you want your infor-
mation to be displayed. Chart is chosen in this example.
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B~ Home Data Source View ~
D S III E (‘ @ i I- & ;?j Geo Point Maps v [a] Images~ | 22 Title g
- ' ’

o - — o0

=] = I- = Range Filter Text Box © Currency C;';
News Pivot  Grid Chart Scatter Pies Gauges Cards Treemap Choropleth .

e Chart Map Filter Elements » !'. Group Edit Colors

File Hist... Insert Dashboard

All the columns that are in the POP CENSUS SUB PLACES layer are dis-
played. Choose a column you would like to display on the Chart you selected. I
chose DOM_AGE. Click and drag this column onto the Value block under Val-
ues in the DATA ITEMS section.

Data Source DATA ITEMS itk «
POP CENSUS SUB PLACES
Values (Pane 1)

=z i 5

v [#] POP CENSUS SUB PLACES | *

DOM_AGE (Count) il

Val
[ab] DM_copE aue il

[ab] DM_NAME
S —————— Arguments
[ab} DOM_AGE

[2B] DOM_ANHHIN
[ab] pom_GENDER

[ab] DOM_INDMIN

Argument

B

Series

B

Series
|ob| DOM_LANG

[ab] DOM_LSM
(ab] DOM_LSM_GR HIDDEN DATA ITEMS
|ab] DOM_RACE

(58] DOM_URT Dimensions

a —

|ab] LM_CODE Dimension

[ab] LM_NAME -

DOM_AGE value is by default (Count) as this column doesn’t have purely nu-
meric values to do (Sum) etc.

To display the different age categories, select DOM_AGE again and drag it
onto Argument block under Arguments.
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& Dashboard Designer - New DashBoard - O X

Chart Tools

E- Home Data Source View Data Design ~

e - [ | .\ ;?j Geo Point Maps ¥ EI Images v @ % Title L_ﬂ‘
o v EmE - ( @ - &
D o) EESY === III E ‘ - 1= T

3 Range Filter X © currensy G

New - Pivot Grid  Chart Scatter Pies Gauges Cards Treemap Choropleth . &
F_l,:l Chart Map Filter Elements v r. Group f:)v Editcalars

File Hi Insert Trem Dashboard

B

Data Source DATA TTEMS otk

FOP CENSUS SUB PLACES - 1 New DashBoard th

Values (Pane 1)
=12 s Chart 1 th %o I3
 [#] FoP CENSUS SUB PLACES |+

[a5] om_cope e al [l ooM_AGE (Count)

ab| DM_NAME
et Arguments : 80O

DOM_AGE (Count) |

[ab] Dom_aGE

9
DOM_AGE - O s00
[2E] DOM_ANHHIN T - =

A -
|ab] DOM_GENDER Argument 1% Sort Ascending
[a5] pom_momm 1% sort Descending
5] DOM_LANG Senes Sort by »

[ab] pom_Lsm Seiies Top N..
[ab] DOM_LSM_GR v No Grouping

ab| DOM_RACE -
-~ - HIDDEN DATA ITEMS Alphabetical
[c8] pom_urT

|ab] LM_CODE Dimensions

067 i
F1-07 2By |

6-5 36y |
#9-09 8By

6c-52 20y -

ve-0c by
sc-6e abv [l
Fi-0F 26wl
&v-Sk 3By |
¥S-05 2by |

ve-0z =bv [N

61-5T 8By |
65-55 8By |
69-50 8By |
bi-0L 36y |
#8-08 aby
alou pue 58 5By |

Color by »

Rename...

|ob| LM NAME -

Right click DOM_AGE under Arguments where you can choose how to ar-
range your data on the Chart. Sort Ascending is chosen in this example.

Continue choosing and dragging columns in this way that you want displayed on
the Chart.

ﬂ% Dashboard Designer - New DashBoard - O X

Chart Tools

E- Home Data Source View Data Design A

— % i - - AB
D .| o= E III E (‘ @ :- Il- Y §% Geo Point Maps~  [aZ] Images & PO Title Ca
=] z - B Range Filter TextBox X b curreny  Ch
New e Pivot  Grid Chart Scatter Pies Gauges Cards Treemap Choropleth D
r:) v Edit Colors

EI,] Chart Map Filter Elements v ri Group
File Hist... Insert Trem Dashboard

Data Source DATA ITEMS I|=) "
POP CENSUS SUB PLACES - New DashBoard I'l'l

Values (Pane 1)

Chart 1 th %

=z i s
~ [B] POP CENSUS SUB PLACES |+
(28] om_cope i [DOM_LANG (Count) il Il oom_ace (county [l DOM_LANG (Count)

:::  DOM_AGE (Count) al

(ob| DM_NAME value l 250

[ab] DOM_AGE

200
[ob| DOM_ANHHIN Arguments

(28] pom_cEnDER 1 DOM_AGE
[zB] DOM_INDMIN

1

w
=

1

Values

1 1 DOM_LANG
[ab]iDOM_LANG

S R Jl”lll“lmﬂlﬂ |

[ab] DOM_RACE i
[aB] pOM_URT

[ab] Lm_cope

[ab] LM_NAME hd

w

= =

nnz1st
OLOSBS
4y

62-52 aby

)
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&

ysi|Bug
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You can rename DOM_AGE(Count) and DOM_LANG (Count) Values that
are displayed on the Chart by right clicking and selecting Rename.

DATA ITEMS a |
! New DashBoard ik
Values (Pane 1)
T :_ K2
=z: Dominant Age il Chart 1 01 "R
s:: DOM_LANG (C; n Dominant Age DOM_LANG (Count
"  Count - g - - ( )
value Count Distinct 50
» Edit Filter i
Arguments
Clear Filter
i DOM_AG 30
Calculation 3
1 DOM_LA? 00
Format...
Argumer 50
ooy | | THN
"Jlu _____ u: JI._.nl. L JLINLINL, ]I L_iL .___I BN | N PO
Series Rename... w
. L T R TR T E S T PR PR LR X k-
Insert Ttem Dashbeard
DATA ITEMS a
’ New DashBoard th
Values (Pane 1)
T :_ L]
:::  Dominant Age il Chart 1 1P vy
::: Dominantlan.. - il [ pominant Age  [Jl] Dominant Language
Value il 250
200
Arguments
8 1s0
1 DOM_AGE E

To change the name of Chart 1, right click anywhere in the chart area and select
Edit Names. A window will open where you can change the name of your
Chart etc.
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gl KA
Chart 1 th 3 &2
Show Caption ant Age - Dominant Language
250~ M Duplicate
200 X Delete
) ConvertTo »
@ sy W
% * Remove Data ltems
= 100
[% Transpose
a0 .
" ABs  Edit Names I
— ] L_n t___l | I
0 » Edit Filter s r o r o ow
— = m ™
Y. ¢ %E%E%%%T%B%z
X gar WM whN 2 g g
FETPEZPR PR 0T PO
wES wh 28 03 ~ @
Update = [re = N 25
Maximize
— L%
H =l L& |
Dominant Chart th % 3
- Dominant Age - Dominant Language
250
200
o 150
=2
T 100
PR PN | 1 1 P
0
F U rErm > = = I= I= I= = = =m =R
SE828rRu B3R eRw R8s BIRIRS S 2
= o5 ] i~ = o ] ] & nugx
TEISRCECHLYMEECUCEEEE IR RT
iy L WPy iy [ri} N W -

You can add various graphs, charts, etc. to be displayed on your Dashboard at
the same time.

Next example is to select Gauges from the Home tab.
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E- Home
D Open
B save
New
0 save As
File

Data Source
4+ Undo v
2
Redo Pivot
History

View

& @ @ ==

Chart Scatter Pies

Data Design

Chart Map

Insert

Maps ¥

VRS

Gauges Cards Treemap Choropleth Geo Point Range Filter

[a] Images v

H Text Box

Filter Elements v I'. Group

Click on MALES and drag it onto the Actual block under Gauges under DATA
ITEMS. Do the same with the FEMALES column onto the next Actual block.

Data Source
POP CENSUS SUB PLACES

= 12 IF
[1:2] ASIAN_INDI
1.2) BLACK
12| COLOURED
13| COLTV_LIVI
[12] COMMERCIAL
[12] comPL_PRIM
13| COMFL_SECO
13| DISC_WRK_S
13| EMPLOYED
[1:2] ENGLISH
1.2 FARM
13| FARMS

(12| FORM_RESID
[12] HH_2011
13| HIGHER
13| INDUSTRIAL
13| INFORM_RES

[1.2] ISINDEBEL

13); FEMALES !

DATA TTEMS
Gauges
MALES (Sum)
Target
FEMALES (Sum)

Target
Actual
Target

Series

Series

HIDDEN DATA TTEMS
Dimensions

Dimension

Measures

Measure

New DashBoard

Dominant Chart th % 3

- Dominant Age - Dominant Language

240
210
180
150

120

Values

a0

w
=

L

|“Ih u.‘

il

> P e P e P b R
%"%z"%;% “%;“%z“%g“%%
= g ) whHhwxE 28 0l

2B BE WS YL HE &7 52

+2E T2 TE PO o T8 w0

R I
£ 9 =2 0 o

Gauges 1

MALES (Sum)

FEMALES (Sum)

The default operation as you can see is (Sum) for both the columns as they only
contain numeric values. You have an option of right clicking MALES (Sum)
and FEMALES (Sum) and choosing a different operation from the list like Av-

erage ctc.
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Gauges
MALES (Sum) = Dominan
Count
Target n
Count Distinct l
FEMALES (Sum) v Sum
Target Min
Max
Actual
Average
Target More ,
Series » Edit Filter
Clear Filter
Series <
Calculation »
Format..
HIDDEN DATA ITEMS
Rename..
e

As you can see on the Gauges above, the format is R (Rand) which is not appli-
cable for the data I want to display. To change this, click on the cog wheel next
to MALES (Sum) and select the Format tab. Select Actual value then for For-
mat type, choose Number. Click OK.

DATA ITEMS Gauge Options
Sauges Commen | Format
MALES (Sum)

# Select value type:

Target
FEMALES (Sum)
Target
Actual
Target
Series

Series

HIDDEN DATA ITEMS

Dimensions

Dimension

Format type:

{ Unit:

Absolute variation Precision:

Percent of target -
Currency:

Percent variation

Culture:

Custom Format:

Number

Auto

Use dashboard settings

Use dashboard settings

Include group separator

1.23B

Do the same for FEMALES (Sum). (Note: There are many other settings you

can adjust in the Gauge Options window.)
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Gauges 1

3.00M

.00 5.00M

MALES {Sum}

oM

aM

FEMALES (3um)

You can even choose a different Gauge design by going to the Design tab and

selecting the appropriate option.

@ Dashboard Designer - New DashBoard

Gauges Tools

[E- Home Data Source View Data Design ~
— ——
AB =
Count
Show Caption Edit Names  Auto Arrange Arrange in Arrange Full Circular |Half-Circular Left-Quarter Right-Quarter Three-Quarter Linear  Linear  Show Gauge
Columns  in Rows Circular Circular Circular Horizontal Vertical Captions
Common Content Arrangement Style Labels
Data Source DATA ITEMS N D h d 1
POP CENSUS SUB PLACES - ew DashBoar O
Gauges
H = KA = KA
=l iis Dominant Chart th % I | Gauges 1 th %
MALES (Sum)
ASTAN_TNDIT [~] S— - -
BLACK Dominant Age Dominant Language
2.00M 3.00M
COLOURED FEMALES (Sum) ®
240
COLTV_LIVI
- Target 1.00M 4.00M
[12] comMmERCIAL o 10
[t2] coMPL_PRIM ua
= * 3.86M
COMPL_SECO Target 180
0.00M. 5.00M
DISC_WRK_S 150
" ® \
EMPLOYED [Series K MALES (Sum)
3
ENGLISH Series E 120
2M
FARM
”
|1.2| FARMS
HIDDEN DATA TTEMS 1M M
FEMALES 50
FORM_RESID Dimensions .
[12] HH_2011 Dimension ““ ‘ il |I | " 3.75M
HIGHER PO [ T 1T 1Y T T oM am
rEZx 2 EBxZ E_Zwo
Measures Q59 o m o @ o m @
[2] mousTRIAL §g§ﬁ% =S 3%3§ e ﬁ‘ni FEMALES (Sum)
INFORM_RES Measure LERE AETL 2 yg o=
e 37 2o 3 3
[12] rsmoEBEL
] E

10
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Gauges 1, MALES (Sum), and FEMALES (Sum) can be changed per the
above instructions.

Dominant Chart and Gauges 1 set up thus far have been from the same Data
Source — POP CENSUS SUB PLACES. In the next example, | am choosing
another Data Source — SALES AREAS which is also one of my layers.

I would like to add a Text Box this time for my Dashboard.

[E- Home Data Source View Data Design
9, ;
Open . —— Geo Point Maps ¥ Images ¥
B [ e hEQ@e&=E=E W 2 B
B save P = B Range Filter Text Box
MNew Redo Pivot ~ Grid Chart Scatter Pies Gauges Cards Treemap Choropleth .
B save As Chart Map Filter Elements v !.I Group
File History Insert
Data Source DATA ITEMS
'SALES AREAS - New DashBoart
Values
L7 i . ' i I AL £ 3 = | &1 ~—

I would like the average population count, so I set this up under DATA ITEMS
as described previously.

Data Source DATA ITEMS
SALES AREAS
Values
- l A l r 4
e POP_COUNT (Average)
v [B] SALES AREAS Value
[aB] MP_NAME
1.2] CODE_COUNT
12| MP_CODE HIDDEN DATA ITEMS
12| POP_COUNT L
Dimensions
|101] Geometry
Dimension
Measures
Measure

Type in any text you would like in Text box 1 — Double click in this box to be
able to do this.

11
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Text Box 1 th % &1

This is the average population:

Move your cursor in this box to the point where you would like to insert values.
Right click there and select Insert Field. Select value will now show.

Text Box 1

This is the average population:

Select value

Click Select value. I had only set up one fiecld POP_COUNT (Average) in this
example so [ will click on it to choose it. If you had more than one field set up,
then you could choose what you wanted to insert.

Text Box 1 th =0 i

This is the average population:

Select value

| POP_COUNT (Average) i

POP_COUNT (Average) will be displayed.

12
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Text Box 1

This is the average population:

POP_COUNT (Average)

If you click out of Text Box 1 on another area on your Dashboard, you will see
the actual number for POP_COUNT (Average). This is the average population
of the entire layer data.

Text Box 1

This is the average population:

586K

At this point you could consider your Dashboard complete. There are many
other features in the Dashboard Designer that are available. Only the very ba-
sics were gone through. Understanding the above, the rest is self-explanatory.

Click on Save to save your current Dashboard.

1EE Home Data Soun
Open
D P ¥ Undo ~
H save
MNews
- Redo
EL save As -
File History

Click on Save As to save your Dashboard as a Dashboard file.

13
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Gauges Tools

Home

0
D = 4 Undo ~
B save
New
ED save As

File

Redo

History

Data Source

View Design

Data
— —

b hE¢®

Grid  Chart Scatter Pies Gauges
Chart

Pivot Cards

Insert

I- .\ }?j Geo Point Maps v
1=

Treemap Choropleth

Map

[aZ] Images v E
Text Box

Filter Elements ri Group

oo Range Filter

Data Source
POP CENSUS SUB PLACES

= 12 I

~ [8] POP CENSUS SUB FLACES |4
[ab] om_cope
[aB] DM_NAME
[cB] DoM_AGE
[G5] DOM_ANHHIN
[c5] DOM_GENDER
[aB] DOM_INDMIN
[aB] DoM_LanG
[ab] DOM_LSM
[b] DOM_LSM_GR
[B] DoM_RacE
[g5] DOM_URT
[aB] LM_copE
[aB] LM_NAME
[gB] MP_NAME

% Export dashboard

1 « Prim.. > Latest Routabl..

Organize New folder

~

# Quick access

&8 Dropbox

@ OneDrive - Personal

@ OneDrive - PrimeThought Software Soluti
{E PrimeThought Software Solutions CC

= This PC

v O

Name

Shapefiles

X
2 Search Latest Routable Netw...
Status

©A

File name: | ‘

Save as type: | Dashboard files (*.dashboard)

~ Hide Folders

Save

Cancel

[ab] PrROVINCE

[chl caiee apea

Click on Open to open a previously saved Dashboard file. (Note: If you try and
open a Dashboard file that was created from another workbook with different
layers, it won’t display saved data correctly.)

When you first opened Dashboard Designer an item New DashBoard was au-
tomatically added to the Dashboards tab.

14
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Name
T Qe

»  New DashBoard

&% Layers  Dashboards

Since you are complete with designing your current Dashboard, you can close
the Dashboard Designer window and click New Dashboard where you can
change the name of your Dashboard.

Mame
T |afc

» Dashboard Test

Viewing Dashboards

Click on the View Dashboard icon to view the dashboard that was just set up —
Dashboard Test. If you had another dashboard set up, you would first select
that dashboard then click on View Dashboard.

15
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MName
T e
¥ Dashboard Test

The Dashboard Viewer window will open. The numbers being displayed are
totals of all the data. Filter on Selected is not checked on.

‘.4% Dashboard Viewer - Dashboard Test |_| Filter on Selected — O x
New DashBoard th
th % II  Gauges1 th % Il

Dominant Chart

250

200

FHRE]
= 2.00M 3.00M
™
= 100
50 | | 1.00M
0 |l||ll......n. n...nlll LI ||II I,n‘ .,,,l | —
HER S S ELE LT R P
O F oENITRERNZT WA 2T URE TR 0.00M
R T - I A
AR LR MR EELE T
MALES (Sum)
Text Box 1 th %
2M
This is the average population:
iM 3M
586K
3.75M

oM 4M

FEMALES (Sum)

To get out numbers of selected items, check on Filter on Selected.

16
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& Dashboard Viewer - Dashboard Test [] Filter on Selected - m} X
New DashBoard th
Dominant Chart th % I  Gauges 1 th % I
1
0.8
w 0.6
[
=
o
> 04
0.2
0.00
0
MALES (Sum)
Text Box 1 th % I

This is the average population:

FEMALES (Sum)

There 1s no information displayed here yet as no items have been selected yet on
the graphics. Go to the Layers tab and ensure the layer that is referenced as the
Data Source for your Dashboard is checked on.

[v] ® % Points
D @ wme Stores
"] %3 e BOUNDARY
b-[ | = we| RADIUS 2-10KM
i | - e SALES AREAS
W % FOP CENSUS SUB FLACES
i.{v]a % Google Roads

&% Layers  Dashboards

17
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Now select an area or areas using one of the selection tools. The exact numbers
for the selected areas will be displayed on the Dashboard Viewer.

- Dominant Age - Dominant Language

1.5

2
1
0

English
Age 40-44
Isizulu
Age 40-44

Values

Afrikaans

Age 35-39
Afrikaans English
Age 25-29 Age 35-39

Text Box 1 th % I

This is the average population:

% Dashboard Viewer - Dashboard Test Filter on Selected = O X
New DashBoard th
Dominant Chart th % I | Gauges 1 th % Il

10.00K

15%

MALES (Sum)

0.00K 20.00K

10K

5K 15K

0K 20K

FEMALES (Sum)

Tools Utilities Routf]
x 6 selected r".'l ﬁ -

Selection

Edit

t dlick to cycle ﬁ 166 237 -| @ 28.111; -26.336

faees

Note: Text Box 1 number will not be displayed if Filter on Selected is checked
on as this was created from a different Data Source — SALES AREAS.

To display the value in Text Box 1, ensure SALES AREAS is checked on in the
Layers tab. Then using one of the selection tools, select 2 or more areas from
this layer. The average population number will then be displayed.

18
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@& Dashboard Viewer - Dashboard Test [+/] Filter on Selected

New DashBoard

Dominant Chart th 5 I | Gauges 1
1
0.8
w 0.6
(]
E
&
> 04
0.2
0.00
0
MALES (Sum)
Text Box 1 th %

This is the average population

556K

FEMALES (Sum)

blish 10 Publish to Unload | Help bout
tialServer Spatial Reader SpatialXL
~
v
- x
Draw Edit  Selection Tools Utilities RouteXL  Surfaces [ Search
1= BN~ X 2seleced Bl B 1 -
Layers PoXx
« (e R
Description
S<
| Kempton Park 7| @ pepots
~{v] % Foints
= © e Stores
enenl e BOUNDARY
> it RADIUS 2-10KM
B EAS
tsburg

% . Gemiston

q Boksburg
 Depott
L]
«®aim
¢ . Tokoza Sprl'ngs
E S
Garthdale 4 o -
P
9

5 || @ layers  Dashboards

No data will be populated for the other items on the Dashboard Viewer as the
Data Source is the layer POP CENSUS SUB PLACES for them. Only areas

from the SALES AREAS layer are selected.

If you would like to change any design in any Dashboard from the Dashboards
tab, select the appropriate Dashboard and click on the Design Dashboard icon
where you can do this. Save your settings.

Name

T e
¥ Dashboard Test

You can add as many different Dashboards as you want here by clicking

(X

To delete a Dashboard, first select it then click

19
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You can inspect the data of the various charts etc. set up on your Dashboard by
selecting the Inspect Data icon.

Dominant Chart th % I Gauges 1 th %
2
10.00K 15.00K
w 15
[0}
= .
g 20.00K
0.5
; 20£V
IsiZulu 0.00K 25.00K
Age 25-29
MALES (Sum)
Text Box 1 th % Il
10K 15K
This is the average population:
5K 20K
WV
0K 25K
FEMALES (Sum)

Click on the Maximize button ~ to expand any chart etc. to the full area of
the window.

You can Export each chart etc. to Image, Excel, or PDF. You can even get a
Print Preview. You do this by clicking the Export To icon above each chart
etc. and then selecting the appropriate option.

20
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i% Dashboard Viewer - Dashboard Test || Filter on Selected = O X
New DashBoard th B 7
P
Dominant Chart h % I  Gauges1 th %P 1 |hep  ab
Print Preview... i
- Dominant Age - Dominant Language Export To PDF

Export To Image

10.00K 15.00K Export To Excel
1.5
w
g
= 1 5.00K 20.00K
=
0.5
20.3K
0 i e
Isizulu 0.00K 25.00K
Age 25-29
* MALES (Sum)
Text Box 1 130 o
10K 15K

This is the average population:
N— [

To Export or have a Print Preview of the entire Dashboard, select the Export
To icon on the top of the Dashboard.

Note: First expand the entire Dashboard window so you can see all items other-
wise it will be cut off when exporting.

g% Dashboard Viewer - Dashboard Test |v| Filter on Selected = O X

New DashBoard th

Publishing Dashboards to Spatial Reader Files

You need a specific description in your license file to publish Dashboards to
Spatial Reader files. If you do not have this description in your Spatial Publisher
license file, you will be able to publish everything else in the spatial product you
are using except for Dashboards.

o) PTS5-5patialXL-Plus,Bi,EBriefcasesb, ODA,Storyboard-wayne-20201231
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Further Documentation on Dashboards

Further data on dashboards and their features can be found in the DevExpress
documentation.

Support

T: +27871354351

support@primethought.biz - primethought.biz

.m Pri me-Thnughi Kyalami Estate, Midrand, Johannesburg,

Software Solutions 1684, South Africa
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